What’s new in Solid Edge
Proprietary and restricted rights notice; Trademarks

Proprietary and restricted rights notice

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2013 Siemens Product Lifecycle Management Software Inc.

Trademarks

Siemens and the Siemens logo are registered trademarks of Siemens AG. Solid Edge is a trademark or registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks, or service marks belong to their respective holders.
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proprietary and restricted rights notice; Trademarks</td>
<td>2</td>
</tr>
<tr>
<td><strong>Overview of Solid Edge ST6</strong></td>
<td>1-1</td>
</tr>
<tr>
<td><strong>Part enhancements</strong></td>
<td>2-1</td>
</tr>
<tr>
<td>3D goal seeking for part, sheet metal, and assembly models</td>
<td>2-1</td>
</tr>
<tr>
<td>Live Rules</td>
<td>2-1</td>
</tr>
<tr>
<td>Tangency control handles</td>
<td>2-2</td>
</tr>
<tr>
<td>Reflective planes</td>
<td>2-2</td>
</tr>
<tr>
<td>Recognize hole patterns</td>
<td>2-3</td>
</tr>
<tr>
<td>Synchronous patterning enhancements</td>
<td>2-3</td>
</tr>
<tr>
<td>Moving revolved features to synchronous</td>
<td>2-3</td>
</tr>
<tr>
<td>Curvature continuous rounds</td>
<td>2-3</td>
</tr>
<tr>
<td>Synchronous copy and paste</td>
<td>2-4</td>
</tr>
<tr>
<td>Redefine surface command</td>
<td>2-4</td>
</tr>
<tr>
<td>Intersect surface command</td>
<td>2-5</td>
</tr>
<tr>
<td>Multi-body modeling replaces Divide Part command</td>
<td>2-5</td>
</tr>
<tr>
<td>Section curvature comb</td>
<td>2-6</td>
</tr>
<tr>
<td><strong>Sheet metal enhancements</strong></td>
<td>3-1</td>
</tr>
<tr>
<td>Changes to Material and Gage tabs</td>
<td>3-1</td>
</tr>
<tr>
<td>Deformation features across bends</td>
<td>3-1</td>
</tr>
<tr>
<td>New Emboss command</td>
<td>3-2</td>
</tr>
<tr>
<td>Contour flanges on contour flanges now supported</td>
<td>3-2</td>
</tr>
<tr>
<td>Flanges on all linear edges</td>
<td>3-3</td>
</tr>
<tr>
<td>Sheet metal features on thin parts</td>
<td>3-4</td>
</tr>
<tr>
<td>Tab command added to Sheet Metal group</td>
<td>3-8</td>
</tr>
<tr>
<td>Dimples and drawn cutouts support multiple closed profiles</td>
<td>3-8</td>
</tr>
<tr>
<td>Sheet metal cut size variables now in Variable Table</td>
<td>3-9</td>
</tr>
<tr>
<td>Flatten enhancements</td>
<td>3-9</td>
</tr>
<tr>
<td><strong>Assembly enhancements</strong></td>
<td>4-1</td>
</tr>
<tr>
<td>Frame Enhancements</td>
<td>4-1</td>
</tr>
<tr>
<td>Dynamic edit of part features from the assembly level</td>
<td>4-1</td>
</tr>
<tr>
<td>Assembly part features can create synchronous geometry</td>
<td>4-1</td>
</tr>
<tr>
<td>Create in place command bar</td>
<td>4-1</td>
</tr>
<tr>
<td>When creating a part in place, face geometry can be used to create part</td>
<td>4-1</td>
</tr>
<tr>
<td>features</td>
<td>4-2</td>
</tr>
<tr>
<td>Indian and Russian standard parts now delivered</td>
<td>4-2</td>
</tr>
<tr>
<td>Simplified assemblies can now use bodies to enclose geometry as well as faces</td>
<td>4-2</td>
</tr>
<tr>
<td><strong>Steering Wheel enhancements</strong></td>
<td>5-1</td>
</tr>
<tr>
<td>Steering Wheel enhancements</td>
<td>5-1</td>
</tr>
</tbody>
</table>
Contents

**PMI enhancements** ................................................. 6-1
Streamlined dimension editing ........................................ 6-1
PMI keypoint preview .................................................. 6-3
PMI point locate change ............................................... 6-3

**Sketching enhancements** .......................................... 7-1
Arrange 2D elements ................................................... 7-1
Automatic keypoint locate ............................................. 7-1
Directional fence selection ............................................ 7-1
Freesketch command .................................................... 7-3
Maintain Relationship command ...................................... 7-3
Move, rotate, scale pattern profiles ................................. 7-3

**Simulation enhancements** ......................................... 8-1
Changes to the Probe Table unit display ............................ 8-1
Consolidated beam analysis results reduce file size ............ 8-1
Design optimization for studies ...................................... 8-2
Improved factor of safety results for assemblies ................. 8-3
Improved visibility of assembly connector icon .................. 8-3
Meshing enhancements .................................................. 8-4
New stress and pressure load units .................................. 8-5
New solve option for large-displacement models ................. 8-5

**Document management enhancements** ......................... 9-1
Solid Edge Embedded Client .......................................... 9-1
Structure Editor ........................................................ 9-6
Insight ..................................................................... 9-7
Solid Edge SP ............................................................. 9-8

**Draft enhancements** .................................................. 10-1
2D display performance improvements ............................... 10-1
Allow arcs in non-revolved section views ............................ 10-1
Bolt hole circle enhancements ......................................... 10-1
Create tables from blocks .............................................. 10-2
Edit block geometry in context ....................................... 10-4
Enhancements to drawing view alignment .......................... 10-4
drawing view creation enhancements (View Wizard command) 10-5
Fast access to drawing view caption and colors ................. 10-5
Five new drawing symbols ............................................. 10-6
Gage information displayed in Draft ................................. 10-6
Improved display of vertical dimension text ..................... 10-7
Improved VHL display in assembly drawing views ............. 10-8
Table editing enhancements ......................................... 10-8
In-place editing for inserted objects and symbols ............. 10-9
New alignment options for annotations ............................. 10-9
New cutting plane caption position .................................. 10-10
New commands for aligning dimensions ............................ 10-11
Sheet enhancements ..................................................... 10-12
Slot centerlines, center marks, and callouts ..................... 10-14
User-defined table update ............................................. 10-15
Translator and converter enhancements .............................. 11-1
PDF Export Options dialog box enhanced .............................. 11-1
Support for multiline text enhanced ................................. 11-2
AutoCAD multi-leader objects now supported during import .... 11-2
AutoCAD version 2013 files now supported during import .... 11-2
Draft callouts now exported as multi-line objects in AutoCAD ... 11-2
Simple dimensions exported to JT .................................... 11-2
Solid Edge textures exported to JT .................................. 11-2
SolidWorks Data Migration tool ........................................ 11-3

User interface changes .................................................... 13-1
Solid Edge themes ......................................................... 13-1
Expanded use of document name formula ............................ 13-1
High-Quality rendering mode .......................................... 13-2
Solid Edge Mobile Viewer supports Android ....................... 13-3

Social media ............................................................... 14-1
Solid Edge social media dashboard .................................... 14-1

Administering Solid Edge ............................................... 15-1
Administering Solid Edge ............................................... 15-1
Preferences folder ....................................................... 15-1

User assistance tools ................................................... 16-1
YouTube in Solid Edge ................................................... 16-1
Web-served help .......................................................... 16-1
New Solid Edge Help docking pane ................................... 16-1
Learning materials are available in the Knowledge Center docking pane 16-2
Contextual help ........................................................... 16-2
Chapter

1 Overview of Solid Edge ST6

Here are the highlights of ST6:

YouTube videos in Solid Edge

Now you can use YouTube within Solid Edge to record and share multimedia videos with others.

For more information, see User assistance tools.

User interface highlights

Solid Edge ST6 introduces four user interface themes that offer a predefined arrangement of graphical tools, user assistance tools, and docking windows based on your familiarity with Solid Edge or with other CAD products.

For more information, see User interface enhancements.

Steering Wheel enhancements

Based on user feedback from Solid Edge University 2012, the steering wheel and the Solution Manager now offer better feedback and more user–definable controls.

For more information, see Steering Wheel enhancements and Live Rules.

Document management highlights

Document management enhancements include:

- Support for Multifield keys—Solid Edge Embedded Client ST6 supports Teamcenter’s use of multifield keys to define what makes an Item business object unique in Teamcenter.

- Enhanced multi-CAD capability—The addition of the Take Ownership command provides you with the ability to take ownership of an existing foreign design (assembly or part). Rounds and chamfers have a unique setting for this operation and default to ordered placement.
Chapter 1  Overview of Solid Edge ST6

- Add to Teamcenter Interactive—This new tool provides you an interactive process for adding Solid Edge 3D and draft data to Teamcenter. With a focus on working with unmanaged data that is of a product or project in size, it is particularly suited for supply chain collaboration and reintegration of formerly managed content into Teamcenter.

See Document management enhancements for details regarding the enhancements to Solid Edge Embedded Client, Structure Editor, Insight, and Solid Edge SP.

Part, sheet metal, and surfacing highlights

Solid Edge part, sheet metal, and surfacing enhancements include:

- 3D Goal Seek—Goal seeking now is available for all 3D models. Its purpose is to evaluate “what if” scenarios, and to adjust the design to match a specific value (goal). It operates with respect to the model design variables.

- Now you can create stamped sheet metal parts with a single Emboss command.

- Tangency control handles—3D handles for manipulating continuity and tangency at curve and surface boundaries are now available. There is also a handle for control of the tangency magnitude. The tangency controls used in previous versions are still available. You can turn off the display of these new 3D handles.
• Higher quality surfaces for more stylized products.

• Recognize hole patterns—A new command is available that will detect holes features that form a rectangular or circular pattern. A pattern feature of holes is added to the model.

• Rounding—Rounding now supports the curvature continuous type.

• Copy and Paste—Copy/Cut and Paste now includes the copied feature’s dimensions, relationships, and variables.

• Better reuse with synchronous technology—This includes improved rectangular and circular patterning, pattern recognition.
  o Rectangular Patterning—Improvements made to the rectangular patterning behavior. You can dynamically drag the pattern profile on face, center the pattern on the pattern profile. The pattern is now more predictable and produces desirable drag results. The pattern is easier to constrain and dimensionally edit.

  o Circular Patterning—Improvements made for center positioning of the pattern profile. The command now creates a fixed pattern diameter to instance location. A diameter dimension is automatically added. The edit behavior has been significantly improved.

For more information, see Part enhancements and Sheet metal enhancements.

Assembly highlights

Solid Edge Assembly enhancements include:

• Using face selection, features can be located and dynamic edit can be used to change dimensional values without in place activation. The Undo and Redo commands are available for this operation.
• When creating Part Features from the assembly level (Assembly Part Features), there is now an option to create synchronous features if possible.

• Simplified assemblies geometry can now exist as either solid bodies or visible faces. With this capability, you can create a more accurate representation of a simplified part for review and sharing, yet still protect proprietary information. A new Duplicate Body command speeds simplification of copied or patterned parts.

For more information, see Assembly enhancements.
Draft and PMI highlights

ST6 continues to simplify drawing production and improve the usability of dimensions and annotations in model PMI and on drawings. This includes:

- Direct editing of tables.
- Intuitive and flexible annotation and dimension alignment.
Create a block table and auto-ballooned block diagram using the new Block Table command.

For more information, see Draft enhancements.
Finite element analysis highlights

Solid Edge Simulation introduces design optimization. Design optimization alters one or more design variables in a solved study to maintain a limit and achieve an objective. For example, you can use the New Optimization command to minimize mass yet maintain a stress level that is less than the rated yield stress. You do not have to specify a target value, just an objective to achieve.

Design optimization operates on physical and material properties used to evaluate stress, displacements, and factor of safety.

For more information, see Simulation enhancements.

Web-served help and training

In ST6, user help and training are now accessed over the Internet. However, if you do not have Internet access, you can choose to display locally installed help, instead.

Using web-served help instead of locally installed help provides the following advantages:

- Content that is searchable across all help and training.
- Direct links between help topics and tutorials and videos.
- Access to the Learning Portal.

For more information, see User assistance tools.
Chapter 2  Part enhancements

3D goal seeking for part, sheet metal, and assembly models

Goal seeking is now available in the 3D environments.

- You can use the Inspect tab→Evaluate group→Goal Seek command to resolve what-if questions for 3D part, sheet metal, and assembly models.

  Previously, goal seeking was available only for 2D geometry, such as on drawings and in ordered profile sketches. Now you can calculate solutions directly on models displayed in the graphics window.

- All physical properties associated with a model have been added to the Variable Table and are available for selection in goal seeking.

  For more information and examples, see Using goal seeking in calculations.

Live Rules

Solution Manager and Live Rules options button added to the Live Rules panel.

Options provided to control the face colors used in Solution Manager. You can also control the Live Rules panel type without having to go to Solid Edge options→Helpers page.

An option added to display a legend and tool tips for face colors while in Solution Manager.
When you click the relationship on the palette (1), that relationship is suppressed for all faces in the solution. If you hover over the relationship, a fly out appears (2). Clicking the fly out only suppresses that face from the solution.

**Note**

In the prior release, clicking the fly out suppressed that relationship for all faces in the solution and clicking the relationship on the palette only suppressed that face.

**Tangency control handles**

3D handles for manipulating continuity and tangency at curve and surface boundaries are now available. There is also a handle for control of the tangency magnitude. The tangency controls used in previous versions are still available. You can turn off the display of these new 3D handles.

See Help topic Tangency control handles.

**Reflective planes**

Reflective planes are now available. The reflective planes display a reflection of a symmetrical part instead of an actual mirror feature. This is a quick way of resolving symmetrical form and studying the volume of a sculpted model.

Reflective planes are used for display only. Reflective planes reflect model faces and curves. Reflected faces include both construction and solid faces. Face styles are also reflected. Reflective planes do not reflect coordinate systems, reference planes, sketches, or dimensions.

Use the Reflective planes dialog box to manage the reflectivity settings.
Recognize hole patterns

Imported models can be used in synchronous modeling. Imported models contain no feature definitions. These models are a collection of faces that only describe the model shape. In order for these models to take full advantage of the synchronous modeling and edit behavior, tools are provided to recognize specific faces and arrangement of faces. These recognized faces covert to synchronous features. The converted features behave the same as if they were created in the synchronous modeling system.

Use the Recognize hole patterns command to detect hole patterns. The command is disabled if the file does not contain hole features.

Synchronous patterning enhancements

Rectangular Patterning

• Improved rectangular patterning behavior
• Dynamically drag the pattern profile on face
• Added option to center the pattern on pattern profile
• More predictable and desirable drag results
• Easier to constrain and dimensionally edit

Circular Patterning

• Redesign circular patterning creation and edit
• Improvements for center positioning of the pattern profile
• Create fixed pattern diameter to instance location
• Diameter dimension automatically added
• Edit behavior significantly improved

Moving revolved features to synchronous

Enhanced the Move to Synchronous behavior when moving revolved features. The move creates Live Sections and binds the feature sketch dimensions to the section.

Curvature continuous rounds

Curvature continuous rounding is now supported.
Tangent Continuous (G1)
G1 means the two objects are connected and tangency continuous. The tangent vectors have the same direction, but the radius of curvature may change. They are said to have the same slope.

Curvature Continuous (G2)

G2 means two objects are smoothly connected and curvature continuous. Their tangent directions and both radius of curvatures are equal. They are said to have the same curvature.

**The following features now support G2**

- Synchronous Rounds
- Constant Radius Edge Rounds in Ordered
- Surface Blends
- Variable Radius Round/Blend in Sync and Ordered
- Assembly Rounds

**Synchronous copy and paste**

When copying and pasting a feature, the dimensions, variables, and relationships on the feature are also copied. This applies to both the Move command copy option and the Copy/Paste (Ctrl+C, Ctrl+V) operation.

**Redefine surface command**

The Redefine surface command creates a new surface by replacing existing model faces with a BlueSurf. Once replaced the new surface will behave identically to a manually created BlueSurf.

The example below shows using the redefine surface command to remove the hole on the bib of the helmet.
Intersect surface command

The Intersect Surface command allows users to mutually extend or trim surfaces to a common intersection. You can extend surfaces up to other surface bodies. The trim capabilities supports trimming multiple bodies.

Multi-body modeling replaces Divide Part command

Enhancements to multi-body modeling in previous Solid Edge releases provide a better workflow for creating multiple, related part models from a single parent model than the Divide Part command. Therefore, the Divide Part command has been removed from the Surfacing ribbon.

For multi-body modeling, use the following commands on the Home tab→Solids group instead of the Divide Part command:

1. The Split command (boolean) splits a target design body into multiple bodies, using a tool body to define the split boundary. New design bodies created by the Split command reside in the same file as the original design body, allowing you to continue modeling all of the design bodies in context with one another.

2. With the Multi-body Publish command, you can publish the multiple design bodies as individual parts, and you can also publish an assembly of the parts, positioned as in the original part model, if you like. The new parts that are published from the original multi-body model each consist of a part-copy feature, so that the new models are associative to the original multi-body model. Similarly, if you choose to publish an assembly, the assembly model is associative with the original multi-body part model.

For more information about all that you can do with multi-bodies, see the following help topics:

- Multi-body modeling
- Multi-body publishing
Chapter 2  Part enhancements

Note

You still can access the Divide Part command using the Customize command on the Quick Access Toolbar.

Section curvature comb

Creates an intersection curve between a selected surface or face and a plane. The command switches on or off the display of the section curvature comb. The curvature comb shows the smoothness of a curve.
Chapter

3  Sheet metal enhancements

Changes to Material and Gage tabs

The following changes have been made to the Material and Gage tabs on the Material Table dialog box.

- The Associate Gage Table option is now more visible. It has been moved from the Material tab to the Gage tab on the Material Table dialog box.

- The Use Excel File and Use Gage Table options have been moved from the Material tab to the Gage tab on the Material Table dialog box.

- The Browse button has been removed from the Gage tab so you can no longer browse to select a sheet metal gage file. You specify the gage file with the Solid Edge Options→File Locations→Sheet Metal Gage File path setting.

Deformation features across bends

In the ordered environment, you can now add deformation features, such as beads, dimples, and drawn cutouts across a bend created in version ST6 or later.

You can also create a louver that lies completely inside a bend region.
Chapter 3  
Sheet metal enhancements

For more information, see Adding sheet metal deformation features.

New Emboss command

Use the new Emboss command to create an emboss feature (A) on a selected body (B) using another selected body (C) as the embossing tool.

You can select multiple bodies when you define the embossing tool.

For more information, see Emboss features.

Contour flanges on contour flanges now supported

You can construct a contour flange on an existing contour flange when working in the ordered environment.
For more information, see Constructing Contour Flanges.

**Flanges on all linear edges**

While working in the Ordered environment, you can now construct flanges on non-tab linear edges such as contour flange edges,

Bend edges,
Sheet metal enhancements

And dimple edges.

For more information, see Constructing flanges.

Sheet metal features on thin parts

While working in the Ordered environment, you can now construct sheet metal features along portions of a part that have a uniform thickness.

For example, you can create a thinned part in the Ordered Part environment,

Switch to the Ordered Sheet Metal environment, and add features such as flanges,
Contour flanges,

Dimples, and other deformation features.
Bends created by the sheet metal features can be flattened.
You can use the Flat Pattern command to flatten the design model.

You can also use the Unbend command to straighten the bend as you would with a regular sheet metal part.
Likewise, you can use the Rebend command to reapply the bend to the model.
Tab command added to Sheet Metal group

The Tab command has been added to the Home tab→Sheet Metal group in the synchronous environment.

Dimples and drawn cutouts support multiple closed profiles

You can now select multiple closed profiles when creating dimples and drawn cutouts.
Sheet metal enhancements

Sheet metal cut size variables now in Variable Table

Sheet metal model cut size variables are now added to the Variable Table. You do not have to create a flat pattern of the sheet metal file for the variables to be added. You can set up your templates to expose these variables.

Flatten enhancements

Flatten has been enhanced to maintain features such as chamfers and holes during flatten or unflatten.

You can also flatten deformation features, such as dimples, on bends.
material on bends.
Chapter

4 Assembly enhancements

Frame Enhancements

The origin for a frame can now be defined from a sketch. Previously the default was the centroid of the frame cross section and could only be repositioned by a custom program.

Part edges can be used to define the frame. Single edges, tangent chains, or all the edges on a solid body can be used as input for creating the frame.

Dynamic edit of part features from the assembly level

Using face selection, features can be located and dynamic edit can be used to change dimensional values without in place activation. The Undo and Redo commands are available for this operation.

Assembly part features can create synchronous geometry

When creating Part Features from the assembly level (Assembly Part Features), there is now an option to create synchronous features if possible.

Create in place command bar

Create in place now has a new command bar interface. Template selection is remembered, and new file names can be browsed just as in the save as command. Previously the existing file names and the directory structure could not be seen during the creation of a part in the context of an assembly.
When creating a part in place, face geometry can be used to create part features

When a part is created in place, face selection can be used to create geometry using extrude.

Previously, parts were in-place activated, and inter-part copies of faces, or included sketch geometry was needed to create part features in the context of an assembly. While this workflow is still valid for situations where parametric linking between parts required, now faces can quickly be located for geometry creation with no links created. Other operations, such as Thin Wall, Thicken and boolean operations such as Union, Subtract, Intersect and Split can be used to create geometry while in the context of the assembly. Multi-body geometry can be created also.

Indian and Russian standard parts now delivered

Indian and Russian standard parts are now delivered with the Standard Parts library.

Simplified assemblies can now use bodies to enclose geometry as well as faces

Simplified assembly geometry can exist as either solid bodies, or visible faces. Prior to ST6, Simplified assemblies consisted of face geometry. The ability to create simplified assemblies using face geometry using the Visible Faces command is still valid, however simplified assemblies can also be created by modeling solid bodies which represent the simplified assembly geometry. The simplified assembly model is stored within the assembly file and is created with the Model command.

When creating a simplified assembly by modeling a solid, access to ordered part modeling functionality is available as well as the commands Enclosure and Duplicate Body.

The Enclosure command uses an assembly reference plane to orient the enclosure and the enclosure can consist of a rectangular solid or a cylinder whose size is based on the extend of the parts in the selection set. The solid can then be modified using ordered features, such as rounds and cutouts to better represent the desired simplification.

The Duplicate Body command allows duplication of simplified solid geometry representing assembly components that occur multiple times within an assembly.
Once the simplification of the assembly has been modeled, duplicates of the simplification can be added to the model, much like a pattern feature and the resultant bodies are merged with the original body much like the part pattern body functionality. This is a history based feature and linked with Inter-part to the assembly components.

In the image below, the three enclosures used to create the simplification are duplicated.
Chapter

5  Steering Wheel enhancements

Steering Wheel enhancements

The 3D Steering Wheel has been simplified in Solid Edge ST6. All 3 axes are displayed.

The Steering Wheel in the previous version of Solid Edge is shown below.

![Previous Steering Wheel](image1)

The Solid Edge ST6 Steering Wheel is shown below.

![ST6 Steering Wheel](image2)

In ST6, the Steering Wheel display size can be set in the View tab of Solid Edge options. When using finer screen resolutions, the large display can make the steering wheel easier to see and manipulate. The options are small, medium and large.
Chapter 5  Steering Wheel enhancements

Steering Wheel Overview
Chapter

6 PMI enhancements

Streamlined dimension editing

Now you can access specific dimension editing functions more quickly. Depending on the dimension type (2D or 3D), the dimension behavior (driving, driven, or synchronous locked or unlocked) and where you click, a single click can display:

- All of the dimension editing functions.
- Only the dimension value edit box.
- Only the dimension formatting command bar.

You also can use Alt+click to get the alternate behavior.

3D PMI dimensions (synchronous locked and unlocked)

Dimension text

- Default edit—You can click the dimension text to edit the dimension value and display the Modify Dimension command bar.
  
This is existing behavior.

![Dimension text default](image)

- Alternate edit—You can Alt+click the dimension text to display the dimension formatting options on the Dimension command bar.
  
This is new behavior.

![Dimension text alternate](image)

Dimension lines

- Default edit—You can click a dimension line or projection line to edit the dimension formatting using the dimension command bar.
  
This is existing behavior.
Chapter 6  *PMI enhancements*

- Alternate edit—You can Alt+click a dimension line or projection line to edit the dimension value.
  
  This is new behavior.

**PathFinder**

- Default edit—You can click a dimension name in PathFinder to edit the dimension formatting using the dimension command bar.
  
  This is new behavior.

- Alternate edit—You can Alt+click a dimension name in PathFinder to edit its value.
  
  This is new behavior.

To learn more about 3D PMI dimensions, see PMI dimensions and annotations.

**Automatic dimensions on ordered features**

When dynamically editing dimensions generated automatically on ordered features, you can click the dimension text to edit both the dimension value and the dimension formatting.

You can display only the formatting command bar using Alt+click.

**2D dimensions**

For 2D dimensions on synchronous sketches, ordered profiles, and in the Draft environment, you can:

- Use the same techniques to edit 2D dimensions.

- Change the value of multiple, selected dimensions at once. A blank data entry box is displayed for you to enter a single value.

To learn how, see Edit 2D dimensions (sketch, profile, draft).

**Not-to-scale dimensions**

For 2D and 3D not-to-scale dimensions, you now can click the dimension text to display both the formatting and value editing options.

If you only want to edit the dimension formatting, you can Alt+click the dimension text, instead.

**Jogs in projection lines**

For all dimensions, you can select a projection line and then use Alt+click to add a jog. You can select a jog handle and then use Alt+click to remove the jog.

**Deleting dimensions**

For all dimensions, you can use the Delete key to delete the entire dimension when the cursor is not in the value edit box. Alternatively, you can delete just the dimension value when the cursor is in the value edit box and the value is highlighted.
PMI keypoint preview

The Smart Dimension command now previews the silhouette point when you dimension edges that contain sheet metal bends. For example, when you select the edge near point (1) to start the dimension placement, the command displays the edges and the silhouette point (2). The edge you locate determines the location of the silhouette point.

Note

You can use the I key to switch between the intersection point and the silhouette point modes.

For more information, see PMI dimensions and annotations.

PMI point locate change

Previously, when you added a PMI dimension to a model, the command expected you to select an intersection point. Now the default is for you to select a virtual vertex like the second point in the illustration below.
A virtual vertex is useful when you need to add a PMI dimension to show the size of the part, yet the hard edge was removed due to chamfering or rounding.

To learn more, see PMI dimensions and annotations.
Chapter

7 Sketching enhancements

Arrange 2D elements

You can now arrange the display order of 2D elements using the set of commands in the arrange group located on the Sketching (or Home) tab→Arrange group. Select the elements you want to arrange and then select the command to change the display.

Bring to Front command

You can use the Bring to Front command to move the selected elements such that the elements display in front of all other elements.

Send to Back command

You can use the Send to Back command to move the selected elements such that the elements display behind all other elements.

Pull Up command

You can use the Pull Up command to move the selected elements up one position in the display order of overlapping elements.

Push Down command

You can use the Push Down command to move the selected elements down one position in the display order of overlapping elements.

Automatic keypoint locate

When you drag 2D elements to modify them, the keypoints are now automatically located.

Directional fence selection

In the Draft environment and in ordered sketching in other environments, you can use the directional fence to efficiently select geometry.

Dragging from left to right selects only geometry completely inside the fence as shown below.
Dragging from right to left selects inside and overlapping geometry within the fence as shown below.

**Note**

The opacity and color of the directional fence shading settings are located in the Solid Edge options→Colors tab.

For more information, see Element and object selection.
**FreeSketch command**

The FreeSketch command is now available in the synchronous environment on the Sketching tab→Draw group→Line list. This command allows you to create elements by dragging the mouse in a general path.

For more information, see Draw with FreeSketch.

**Maintain Relationship command**

The Maintain Relationship command displays as enabled in the profile step for an ordered feature.

For more information, see Profile based ordered features.

**Move, rotate, scale pattern profiles**

The user can now move, rotate and scale ordered pattern profiles in the pattern profile step or when defining a pattern profile in sketch. Previously, the user could not select the pattern profile for these commands.

To learn more, see:

- Pattern Features
- Pattern command (3D features)
Chapter

8 Simulation enhancements

Changes to the Probe Table unit display

In the Simulation Results environment, the following changes have been made to the Probe Table:

- The numerical value format is displayed in the column heading.
- The number of decimal places of the value matches the setting on the Color Bar tab→Format group→Decimals list.

**Example**

![Probe Table]

For more information, see the Probing analysis results help topic.

Consolidated beam analysis results reduce file size

In the Simulation Results environment, beam results now are consolidated to reduce the number of results reported. When the beam results are identical for both ends of the beam, EndA and EndB, the results are combined into one value instead of listing them separately. This reduces the number of reported results by half, and simplifies the results display.

**Example**

Instead of showing the results for Beam EndA Plane1 Moment and Beam EndB Plane1 Moment, a single result is reported for Beam Plane 1 Moment.

This change is visible in the Simulation Results environment, in the following locations:
Chapter 8  
*Simulation enhancements*

- Result types available for selection from the Result Component list on the Home tab→Data Selection group.

- Plot names listed in the Simulation pane for these types of plots:
  - Beam End Reactions
  - Stress

For more information, see:
- Beam reaction component plots
- Beam stress component plots

**Design optimization for studies**

One form of design optimization—study geometry optimization—is now available in Solid Edge Simulation. Design optimization is available for all model and study types.

- You can use the Simulation tab→Study group→New Optimization command to resolve what-if questions for any geometry in a study that you have solved. This is similar to 3D goal seeking, but design optimization solves more complex scenarios involving multiple variables (the design objective, design limits, and the variables to change). In addition, you have all of the analytical tools (plots, reports, a spreadsheet, and the data probe) in the Simulation Results environment available for reviewing the results.

For more information, see:
- Optimizing study results.
- Minimize the mass of a part with design optimization

- Simulation study results, which are generated when a study is solved, are available for selection as the design objective or design limit. Simulation study
Simulation enhancements

results include stress, displacement, factor of safety, natural frequency, and buckling load Eigenvalues.

- A variety of model properties and variables have been added to the Variable Table and are available for selection in design optimization:
  - Physical properties associated with a model (mass, volume, surface area) are available for selection as the design objective or design limit.
  - Simulation study variables associated with loads can be selected as design variables.

For more information, see:

- Defining design optimization parameters.
- Best practices for design optimization

- New shortcut commands are available from the Simulation pane to review optimization results, modify an existing optimization, and display the study geometry in different states.

For example:

- The View Summary command displays the optimization results in tabular and graphed format in an Excel spreadsheet.
- The View Plots command displays the plot resulting from the last processing iteration.
- The Edit Optimization command enables you to change one or more optimization variables, and then reprocess the results.

For more information, see Optimizing study results.

Improved factor of safety results for assemblies

Factor of safety simulation results for assembly studies that contain parts with different materials now are displayed and reported for the entire assembly. Previously, factor of safety results were not available when parts in the study had different material properties.

For more information, see Stress component plots.

Improved visibility of assembly connector icon

To improve the visibility of assembly connector icons in the Simulation tree-view pane, the appearance of the icon representing glue connectors and no-penetration contact connectors has been changed to the following: •

This applies to connectors created with the following commands:

- Simulation tab→Connectors group→Auto
Meshing enhancements

A variety of new tools are available to review the mesh and to identify areas of the mesh that need to be improved. These enhancements are available in part and sheet metal, but they are particularly useful in an assembly model.

- A new Show mesh on Close option in the Mesh dialog box enables you to display the mesh independently of the Mesh command.

- Check boxes under the Mesh node in the Simulation tree-view pane show and hide the mesh on individual parts.

Example
• While the mesh is displayed, you can use the new Show Poor Quality shortcut command to locate areas of poor mesh quality.

• After you apply sizing to those areas, you can use the new Remesh command in an assembly model to mesh just the affected part.

For more information, see Examining the mesh.

New stress and pressure load units

A new unit type, N/mm^2, can be specified for stress and pressure loads in structural studies. This unit type is available in the Advanced Units dialog box, which is available from the Units tab in the File Properties dialog box.

For more information, see Assign units in studies.

New solve option for large-displacement models

For linear static studies, a new incremental processing option is available in the Create Study (or Modify Study) dialog box, under Advanced Options. The new option, Large Displacement Solve, specifies that iterative processing is used to solve the study. This produces a more accurate solution in studies where the deflection of the model is large relative to the dimensions of the model.

Example

Consider a sheet metal part with a narrow thickness. If the linear static analysis results compute the displacement of the part to be a high value relative to the size or thickness of the part, then a more accurate solution would be produced using the Large Displacement Solve option.
Chapter 9  Document management enhancements

Solid Edge Embedded Client

Software Compatibility

Solid Edge Embedded Client ST6 is compatible with the following:

<table>
<thead>
<tr>
<th>Solid Edge</th>
<th>Teamcenter Express</th>
<th>Teamcenter Rapid Start</th>
<th>Teamcenter 9.1</th>
<th>Teamcenter 10.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST6</td>
<td>9.1</td>
<td>10.1*</td>
<td>9.1.2.x*</td>
<td>10.1*</td>
</tr>
</tbody>
</table>

* Recommended

Teamcenter Rapid Start replaces Teamcenter Express starting with release 10.1

Teamcenter 9.1 adds 64-bit support (32-bit and 64-bit Teamcenter Server support on Windows)

Solid Edge Embedded Client ST6 is not supported with:

- Teamcenter 9.0
- Teamcenter 8.x
- Teamcenter 2007.2
- Teamcenter 2007.1
- Teamcenter Engineering
- Any Teamcenter Express version based on any of the above.

The Solid Edge Teamcenter Administrator installation is required for Teamcenter. The Solid Edge Teamcenter Administrator installation kit includes the Solid Edge Overlay Template for each supported Teamcenter release. This template is used by the Teamcenter Environment Manager (TEM) and is required for upgrades to Teamcenter or new installations of Teamcenter. Solid Edge Teamcenter Administrator should be installed on the Teamcenter server.

Teamcenter Preferences

New Teamcenter preferences introduced with this release:
**Chapter 9  Document management enhancements**

**SEEC_UOM_List_as_Geometric**
Lists units of measure values that represent geometric components. It is a multi-line preference where a row represents a unit of measure value. When the unit of measure is either each or a value included in the new preference, the document is assumed to be geometric.

**SEEC_TakeOwnership_Limit**
Determines the number of objects that can be selected for a single multi-CAD Take Ownership transaction.

**SEEC_DrivenReference_DoNotCopy_Revise**
Provides for an override of deep copy rules. Specifies a list of dataset types that should not be copied to a new revision. This preference is specific to Take Ownership workflow and design reuse of geometry using multi-CAD.

**SEEC_DrivenReference_DoNotCopy_SaveAs**
Provides for an override of deep copy rules. Specifies a list of dataset types that should not be copied to a new revision. This preference is specific to Take Ownership workflow and design reuse of geometry using multi-CAD.

**SEEC_ExpandStructure**
Determines how Solid Edge expands product structures. Valid values are integers 0 or 1. Enter 0 to expand all levels. Enter 1 to expand the structure, one level at a time.

**SEEC_ItemTypeList_StructureEditor**
Contains list of available Item Types when creating a new Item in Solid Edge Structure Editor.

**SEEC_Search_NamedQueries**
Defines the named searches you want to use with Solid Edge Search. Enter one named search per line. The default value, All, displays all the named searches returned by Teamcenter.

See the Teamcenter Preferences section of the *Solid Edge Embedded Client Administrator’s guide* for additional information.

**New default document name formula**

The default Document Name Formula used by Solid Edge Embedded Client is changed from `[ItemID]/[Item Revision]:[Item Name]` to `[Object]`.

The default Document Name Formula is defined on the Helpers page of the Solid Edge Options dialog box.

For more information, see Helpers page (Solid Edge Options dialog box).

**Expanded use of document name formula**

The Document Name Formula gives you the capability to replace the display of a document’s file name with a formula composed of document properties. The display of the document name formula is now implemented throughout the Solid Edge user interface including:

- Property Manager
• Occurrence Property Manager
• Physical Property Manager
• Alternate Assemblies Table
• Configuration Manager
• Assembly Statistics
• Insert Assembly Copy
• Inter-Part Manager
• Reports

To learn more, see these help topics:
• Using the Document Name Formula
• Document Name Formula dialog box
• Helpers page (Solid Edge Options dialog box)

**Multifield key support**

Solid Edge Embedded Client ST6 supports Teamcenter’s use of multifield keys to define what makes an Item business object unique in Teamcenter.

Teamcenter defines Item business object uniqueness using a single property, Item ID. Beginning with Teamcenter 10, Item business object uniqueness is extended to include additional properties (such as Item ID and Type). When the Teamcenter functionality is deployed, Solid Edge ST6 is able to reuse the Item ID for instances of different Item business objects (such as Item, Design, Drawing, and Document).

For more information, see Using multifield keys in a Teamcenter managed environment.

**Enhanced multi-CAD capability**

Multi-CAD capabilities are enhanced with the addition of the Take Ownership command. This new command provides you with the ability to take ownership of an existing foreign design (assembly or part). The command revises the current revision and creates a new revision where Solid Edge is the CAD author, and enables you to add geometric value to the Item Revision.

For more information, see Take Ownership command.

**Visualization of Adjustable and Alternate Position Assemblies**

Solid Edge Adjustable Assemblies and Alternate Position Assemblies are integrated with Teamcenter to ensure what you see in Solid Edge is the same as what you see in the Teamcenter Rich Client.
No interaction is required for consistent visualization of Adjustable Assemblies. However, the Manage page of Solid Edge Options dialog box now contains the option to Synchronize Alternate Position Assemblies. Enabling the option for Alternate Position Assemblies saves each alternate assembly member as a Teamcenter Arrangement. You can specify the default arrangement when you close an assembly by selecting it in the Default Member column of the Upload Document dialog box.

For more information, see the Alternate Assemblies help topic.

Integration of Simplified Assemblies

The architecture required to support the integration of Solid Edge Simplified Assemblies into the Teamcenter managed environment is complete in ST6. Solid Edge uses a form to capture the existence of a simplified assembly and attaches it to the Solid Edge Assembly Dataset. Existing Teamcenter managed documents that contain simplified assembly data are updated the next time they are checked out and subsequently saved to Teamcenter.

Solid Edge performance benefits from the existence of a simplified representation of an assembly when you are working with complex or large assemblies. Solid Edge Embedded Client is expected to expand the architecture enhancements in ST6 in a future release to include the same benefits when Teamcenter product structure is expanded or the configured Item Revisions are downloaded.

Enhancements to Search

You can now configure search to limit the list of Named Searches using the Teamcenter Preference SEEC_Search_NamedQueries.

Additionally, the Search dialog box is enhanced to use displayable names (names based on language or locale) within search criteria in Solid Edge and Structure Editor. Images are included within the criteria fields to assist you in determining the type of criteria being defined.

For more information, see Search dialog box.

Additional column manipulation commands

You now have three new column manipulation shortcut commands to use in Solid Edge Embedded Client and Structure Editor when you are working within common property dialog boxes (New Document dialog box, Upload document dialog box, Cache Assistant, and so on). You can:

- Use the Hide command to turn the display of columns off as needed.

- Fit all columns based on the width of the largest field in a column using the Best Fit command.

- Fit a column width by the width needed by the largest field in the selected column using the Best Fit by Row command.

For more information, see Manipulate Columns.
Cache Assistant available from Add to Teamcenter

Cache Assistant provides valuable tools that are useful during the process of adding unmanaged documents to the Teamcenter-managed environment. You now have the option to access the Cache Assistant from the Add to Teamcenter dialog box, eliminating the need to start Solid Edge or Structure Editor to access it.

See the Add to Teamcenter dialog box help topic for additional information.

Improved Add to Teamcenter messaging

Add to Teamcenter messaging is improved to make it easier to understand which files are imported into Teamcenter and which files have warnings or errors. You can view all details in a single view without having to view multiple log files.

For more information, see Working with Add to Teamcenter.

Optimized Add to Teamcenter process

The Add to Teamcenter process is optimized to improve the start of the application and to delay the Teamcenter login to only appear when you:

- Click Browse for Folder.
- Select the Revision Rule list.
- Click Cache Assistant.
- Click OK to start the import of unmanaged documents.

The result is an improved interaction with Add to Teamcenter.

See the Add unmanaged documents to Teamcenter help topic for additional information.

Add to Teamcenter – Interactive

While Add to Teamcenter continues to be the application for bulk import and a critical path in getting existing Solid Edge data into Teamcenter, this new tool provides you an interactive process for adding Solid Edge 3D and draft data to Teamcenter.

With a focus on working with unmanaged data that is of a product or project in size, it is particularly suited for supply chain collaboration and reintegration of formerly managed content into Teamcenter. Data validation and error checking are combined into an interactive user interface to assist you with managing your designs.

Add to Teamcenter Interactive is available to you when you install the Solid Edge Teamcenter Client and it includes robust help information to assist you with using the application.
Structure Editor

Support for Teamcenter display names

When Solid Edge Structure Editor transacts data with Teamcenter, it uses a name that is unaffected by localization. This is referred to as the real name. The real name has also been used for the display of the object's Item Type name in the user interface. (Example: Design) However, with the introduction of Teamcenter 8.3, the new BMIDE templates require a unique prefix for each name. The prefix is added to all new business objects to guarantee uniqueness. (Example: SE99_Design). The resulting name is often not desirable for display in the user interface.

Support for the use of the display name for the Item Type addresses this issue and brings consistency in what you see in Solid Edge Structure Editor when compared to Teamcenter Rich Client.

Some things to be aware of:

• The object’s display name is used for presentation in the user interface only. Solid Edge continues to interact with Teamcenter using the real property name and real property value.

• There is no change to the process an administrator uses to define the property mapping between Teamcenter and Solid Edge.

• A new preference, SEEC_ItemTypeList_StructureEditor, is created to determine the list of Item Types displayed in Structure Editor.

  For more information on the new preference, see the Solid Edge Embedded Client Administrator’s Guide.

Meta model compliance

Meta model compliant applications are capable of discovering the properties required to create an object and then submit that information back to the application requiring the information. In the case of Solid Edge Structure Editor, Teamcenter can mandate that certain properties are required at the time of the object’s creation. Solid Edge queries Teamcenter to determine these requirements and lets you enter the values so the object is created. The properties are only shown at the time of the object’s creation and they are not saved in the Solid Edge CAD files.

The objects where the meta model can be used are:

• Item

• Item Revision

• Item Master Form and Custom Master Form

• Item Revision Master Form and Custom Item Revision Master Form

The Structure Editor New Document dialog box is modified to show required properties delivered with Solid Edge along with meta model properties and mapped properties. When a document is created, the properties delivered with Solid Edge are shown first in the New Document dialog box, followed by the meta model properties and the mapped properties. After the new object is created, only the mandatory and
mapped properties are shown. The selected Item Type determines what meta model properties are presented as required fields.

for more information, see the Meta model help topic.

**Support for naming rules and revision naming rules**

Naming rules define how newly created objects are named and numbered. The naming rule pattern is determined by the selected Item Type.

Naming rules consist of two components: a pattern and a counter. The pattern is a variable that defines the format (Example: NNNNN), and the counter is used to define the increment each time it is used.

Naming rules are implemented as follows:

- Naming rules applied to the Item ID Pattern and Item ID.
- Naming rules applied to the Revision Pattern and Revision.
- Naming rules applied to the Item Name.
- Revision Naming Rules defining the naming convention and sequence for a revision property.

For more information, see the Naming rules and revision naming rules help topic.

**Insight**

**Insight Software Compatibility**

Options you have for installing and configuring Insight ST6 with SharePoint for this release are:

- Microsoft SharePoint
  - SharePoint Foundation 2010 (64-bit)
    
    *Search Server Express is required with SharePoint Foundation 2010.*
  - Microsoft SharePoint Server 2010 (64-bit)

- Operating System
  - Microsoft Windows Server 2008 (64-bit)
  - Microsoft Windows Server 2008, R2 (64-bit)

- Microsoft SQL Server
  - SQL Server 2008 (64-bit)
  - SQL Server 2008, R2 (64-bit)
  - SQL Server 2012 (64-bit)

Insight ST6 is not supported with:
• SharePoint 2013

• Microsoft Windows Server 2012

  **Note**

  Requires SharePoint Service Pack 2. At the time of release, Microsoft had not made the service pack available.

• Windows SharePoint Services 3.0

• Microsoft Office SharePoint Server 2007

• Microsoft SQL Server Express

• Microsoft SQL 2005

  **Tip**

  Be sure to check both the Solid Edge and Insight *Readme.htm* files to be aware of any last-minute information that is available. The *Readme.htm* files are available in the application folders on your Solid Edge installation media.

### Solid Edge SP

**New preview options**

The Preview/Properties Card window expands to show embedded contents, giving you immediate access to related documents. From the expanded view you can perform various actions, depending on the object selected:

• Open the object in an editor.

• Go to the location of the object.

• Send the object to the Relation Browser.

To quickly identify the contents of projects, carts, ECOs, and ECRs, you can now also associate images with those types of containers.
Improved reporting

Enhancements to the reporting capabilities include new:

- Report templates for projects and ECOs
- Filters for My Projects/My Change Orders
- Status information reporting
Enhanced search

To help you quickly find data that is checked out, the search now includes two new out-of-the-box searches: Checked out to me and Checked out to others. Also, to help you quickly review your latest search, the search page saves the criteria of your most recent search as Last Search, in the Saved Searches box. When you return to the search page, it displays the most recent search and the results.

You can now add saved searches to the Favorites list in the Content Browser.

The overall search experience has also been improved with the addition of icons and the ability to search multiple locations.

Relation Browser enhancements

When you view objects in the map view of the Relation Browser, you now have the option to display the thumbnails or the icons associated with each object.
Simplified workflow

The out-of-the-box Solid Edge SP workflows can now be viewed and edited in Microsoft SharePoint Designer. Solid Edge SP administrators will benefit from new and improved action handlers and improvements to workflow tracking and logging.
Chapter

10 Draft enhancements

2D display performance improvements

Display improvements for the Draft environment include:

- Faster crosshatching in drawing views.
- Faster display of 2D geometry. For example, a block may display as a rectangle during a view operation such as pan.
- Faster file open display by changing the default value for Enable “Undo All” for profile/sketch modifications setting to unchecked.

The option is in the Solid Edge Options dialog, on the General tab. For more information see the help topic, Undo All command Undo All command.

Allow arcs in non-revolved section views

Now you can create a non-revolved section view using a cutting plane line that contains curved elements, such as arcs or fillets.

To use this capability, clear the Revolved Section View option on the Section View command bar before you click to place the view.

Previously, you could only create a revolved section view with a cutting plane line that contains arcs.

Note

Arcs in cutting planes must be connected to a line at both ends. You cannot begin or end a cutting plane with an arc. For more information, see the help topic, Section views.

Bolt hole circle enhancements

A number of enhancements were made to the Bolt Hole Circle command. Now you can:

- Create a bolt hole circle by specifying its diameter. The new creation option, By 2 Points, is available on the Bolt Hole Circle command bar.
- Create a bolt hole circle that is less than 360 degrees using the new Trim option on the Bolt Hole Circle command bar.
• Adjust the length of a trimmed bolt hole circle segment using the round edit handles displayed at either end.

• Locate the following new geometry types during bolt hole circle creation:
  o Arcs
  o Hidden lines

  **Note**
  Center marks now are placed automatically on all bolt hole circle geometry.

For more information, see Place a bolt hole circle.

### Create tables from blocks

Now you can generate an associative table from block diagrams and from other types of drawings that contain blocks.
For more information, see Block tables.

**New Block Table command**

The new Block Table command creates a block table similar to a parts list from all of the visible blocks on the active sheet or in a selected drawing view, or from a user-defined selection set. You can use the Auto-Balloon option to generate balloons that identify the item number and quantity for each block referenced in the block table.

You can specify the type of block list that you want to produce using the List Options on the Options tab in the Block Table Properties dialog box.

In the Draft environment, the Block Table command is available from the ribbon in the Home tab→Tables group. When the 2D Model sheet is active or in Solid Edge 2D Drafting, it is located on the Tables tab. Use Command Finder to find the location of the command in your specific environment.

**New block property text codes**

To display block properties in an annotation, you must create references between the properties entered in the Block Properties dialog box and the property text string of the callout or balloon. Use the new property text strings to do this.

**Example**

- `%(Block Name|GBLM)` (displays the block name in the callout)
- `%(Block View Name|GBLM)` (displays the block view name in the callout)
- `%(Block Label|GBLL)` (where Block Label references the block label name)

For more information, see Referencing block properties.
Edit block geometry in context

A new, contextual edit mode is available for editing block occurrences. Contextual editing allows you to view the block geometry as well as all surrounding objects on the sheet.

You can edit a block in context using the new Edit command on the shortcut menu of a selected block. In this mode, you also can select and add geometry to the block using the new Add to Block command, as well as remove elements from the block using the new Remove from Block command.

For more information, see the following help topics:

- Editing blocks
- Edit a block in context

Enhancements to drawing view alignment

Keypoint alignment
Drawing view alignment now is associative between keypoints. This ensures that drawing view geometry in 2D Model views and 3D part views:

- Maintains the proper alignment between keypoints in two associated views, even when the geometry is scaled, cropped, cut away by break lines, or otherwise modified.
- Uses the true keypoint position to align the drawing views.

Break line associativity
Two new shortcut commands are available to copy and align the break lines on principal, section, and auxiliary drawing views:

- Inherit Break Lines command
• Remove Break Line Inheritance command

To learn more, see the help topic, Copy break lines between drawing views.

Removing default alignment

The Delete Alignment command now can be used to delete the default alignment between a source view and its section view or auxiliary view.

Drawing view creation enhancements (View Wizard command)

The following enhancements are available for the View Wizard command.

Simplified drawing view creation workflow

Now you can adapt the View Wizard command to your preferred drawing view creation workflow by choosing whether you want to run it in simplified mode or in step-by-step mode. Simplified mode is now the default mode for the View Wizard command.

You also can specify that the View Wizard command is used to create drawing views from a model dragged onto a drawing sheet.

For more information, see the View Wizard command.

Preview mode for drawing views

When placing a drawing view, you can specify a preview mode based on the model type and size. A new option on the Drawing View Wizard tab, Dynamic display, specifies when to use a VHL model preview, and when to use a preview that only indicates the extent of the view.

More functionality on the View Wizard command bar

More options are available on the View Wizard command bar, so that you can apply them to a drawing view before it is placed on the drawing. They also provide access to individual dialog boxes in the Drawing View Creation Wizard when using the simplified View Wizard workflow.

For more information, see the View Wizard command bar.
Saved settings by model type and size for drawing views

Now you can create saved settings for drawing view creation. A new Drawing View Creation Wizard (Saved Settings) dialog box is available from the View Wizard command bar to name and save the drawing view formatting properties.

You can map drawing view saved settings to model types (part, sheet metal, and assembly) and model size (small, medium, and large assemblies) using the Drawing View Wizard tab (Solid Edge Options dialog box).

New Drawing View Wizard options

A new Drawing View Wizard tab (Solid Edge Options dialog box) specifies which View Wizard command workflow to use, maps drawing view saved settings by model type, and specifies the type of drawing view preview to use.

Fast access to drawing view caption and colors

The following options now are available on the Drawing View Selection command bar when you select a drawing view:

- Caption
  Enters or modifies one or more lines of plain text, property text codes, and symbols for the primary caption.
  To learn how, see the help topic, Add a caption to a drawing view.

- Use model colors
  Applies model colors to drawing view edges and hatching.

Previously, you had to open the Drawing View Properties dialog box to access these options.

Five new drawing symbols

Five new symbols are available for identifying geometric tolerances and specifying values on drawings.

<table>
<thead>
<tr>
<th>New geometric characteristic symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
</tr>
<tr>
<td>%CX</td>
</tr>
<tr>
<td>%AP</td>
</tr>
<tr>
<td>%AX</td>
</tr>
</tbody>
</table>
Other new symbols

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Displays this symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>%GE</td>
<td>Greater than or equal to</td>
<td>≥</td>
</tr>
<tr>
<td>%LE</td>
<td>Less than or equal to</td>
<td>≤</td>
</tr>
</tbody>
</table>

You can add these symbols:

- By inserting them through the Select Symbols and Values dialog box.
- By entering the matching three-character property text codes in a dialog box.

For more information, see Insert a symbol into annotation text. For a complete list of symbols and codes, see Property text codes.

Gage information displayed in Draft

Sheet metal gage information stored in the gage table on the Material Table dialog box is now displayed as property text in Draft and in model environments using PMI. Gage information can be accesses as property text in the following types of properties:

- From Active Document – {%{Gage} (Only available for PMI in sheet metal file)
- Named reference – {%{Gage | <name of sheet metal file>}
- Index reference – {%{Gage | R1}
- From graphic connection – {%{Gage | G}
- From graphic connection to part – {%{Gage | GP}

If there is no gage defined for the sheet metal file, the Gage property text value and the Gage column in the parts list remain blank.

Improved display of vertical dimension text

When the orientation of text in a radial dimension is set to Vertical, the dimension text and the dimension break line now are displayed properly.

**Note**

This improvement applies to the following options on the Text tab (Dimension Style and Dimension Properties dialog box):

- Orientation (Vertical, Parallel, Horizontal, Perpendicular)
- Position (Above, Embedded)
- Override pulled-out text 2
Chapter 10  

Draft enhancements

Improved VHL display in assembly drawing views

Visible and hidden line display in assembly drawing views has been improved in ST6. Lines in occluded parts now are shown correctly in the drawing view. This results in fewer instances where you need to use the Draw In View command to redraw missing lines.

The VHL improvements apply to assembly drawing views when the Show edges hidden by other parts check box is selected on the Display tab (Drawing View Properties dialog box) or in the Drawing View Display Defaults dialog box.

**Note**

When you change the hidden edge display in a drawing view, you can use Ctrl+Shift+Update Views to refresh the display.

Table editing enhancements

**Direct editing for tables**

Now you can double-click a table to edit its formatting and content directly, bypassing the Table Properties dialog box. When an orange edit frame is displayed around the table, you can select one or more table cells to edit. This capability is called direct table editing.

<table>
<thead>
<tr>
<th>(T1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(H1)</td>
</tr>
<tr>
<td>(H2)</td>
</tr>
<tr>
<td>(C1)</td>
</tr>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
</tbody>
</table>

- You can edit the contents of a table cell by typing directly in the cell when it is selected.
- You can use the table formatting command bar to edit the appearance of the selected cells.

Previously, double-clicking a table opened the Table Properties dialog box, where you made formatting changes on the Title tab, the Columns tab, and the Data tab. You still can open the Table Properties dialog box by selecting the table and then selecting the Properties button on the command bar, or by selecting the Properties command on its shortcut menu.

Direct table editing is available for all tables except hole tables in the Draft environment and in Solid Edge 2D Drafting.

For more information, see Edit a table in place.
Full control for the table title and column heading height and width

The following new formatting options are available for title rows and column header rows:

- **Fixed row height**
  A new option on the Title tab in the Table Properties dialog box, *Fixed row height*, defines an exact height for the table title text.

  If you clear this option, the title content controls the height of the table title row.

  **Note**
  Although it is not a new option, you can use the *Adjust text to title width* check box on the Title tab to force a long title to fit into the specified row height.

  When in-place editing the table, you can use the new *Adjust text to column width* option on the Table Format command bar to do this.

In-place editing for inserted objects and symbols

Editing of foreign objects and symbols inserted into a draft document has been improved.

- Now you can use the new Edit command on the shortcut menu of an object or symbol to in-place activate it so that you can edit it directly in the draft document. Previously, only the Open command was available to open it in its native application.

  For more information, see Activate an object for editing.

- In-place activation applies when you link or embed an object using the Insert Object command, and when you place a symbol using the Link, Embed, or Shared Embed symbol placement method.

- The new edit behavior is the default behavior when you double-click an embedded, but not a linked, object or symbol. However, a new option on the General tab in the Solid Edge Options dialog box (Draft environment), *Double-click to open embedded objects in native app* (Excel, Word, etc.), lets you reset the behavior to that of previous releases.

  For more information about OLE objects and symbols, see:
  - Importing and inserting documents
  - Symbols overview

New alignment options for annotations

Several improvements for aligning annotations are available in Draft.

- **Associative alignment for annotations**
You can use the new Home tab (or Sketching tab)→Annotations group→Annotation Alignment Shape command to create simple geometric shapes, which you can use to align or arrange one or more types of annotations. You can select and modify the geometry of any annotation alignment shape. For more information, see Annotation Alignment Shape command.

- **Associative alignment patterns for auto-balloons**
  Associative annotation alignment shapes are created automatically by the Parts List command. Before you click to place a parts list, you can select an alignment shape using the Pattern option on the Balloon tab in the Parts List Properties dialog box. The item balloons are associated with, and arranged by, the pattern shape you selected.

  After the parts list is placed, you can select the pattern shape and then use options on the Annotation Alignment Shape command bar to reorder the balloons in a clockwise or counterclockwise direction.

  For more information, see Annotation Alignment Shape command.

- **Locating associative alignment shapes**
  A new Home tab (or Sketching tab)→Annotations group→Show Annotation Alignment Shape command makes existing alignment shapes visible when you select an annotation that is associated with it, or when you create a new annotation that uses annotation shapes.

  For more information, see Show Annotation Alignment Shape command.

**New cutting plane caption position**

A fourth option is now available for positioning the label in a cutting plane caption with respect to the cutting plane view direction line and its terminators. The new option, Direction Line Outside Open End, can be selected from the Cutting plane caption location list on the Caption Format tab (Drawing View Style dialog box). The Caption Format tab is available when you define view annotation captions for cutting planes within the drawing view style.
**Example**

Cutting plane label F is located outside the open end of the cutting plane view direction line, and aligned with the tail of the terminator.

In (A), the view direction lines are set to Point away from the cutting plane.

In (B), the view direction lines are set to Point toward the cutting plane.

For examples of the other caption location options, refer to the Caption Format tab (Drawing View Style dialog box).

For more information about defining view annotation captions, see the Help topic, Working with view annotation captions.

**New commands for aligning dimensions**

There are new commands for aligning dimensions in the Draft environment, when sketching, and for PMI.

**Arranging dimensions**

- You can use the new Home tab (or Sketching tab)→Dimension group→Arrange Dimensions command to automatically group, select, and arrange linear dimensions so they don’t overlap drawing view geometry and annotations.
  
  For more information, see the Arrange Dimensions command.

- **Aligning dimensions using sets**

  ST6 introduces the concept of a dimension alignment set, which enables you to align dimensions that you are adding or editing. New commands are available to maintain and remove a dimension from a dimension alignment set. These commands are located on the ribbon in the Home tab (or Sketching tab)→Dimension group.

  o  Maintain Alignment Set command
Sheet enhancements

The following enhancements are available for drawing sheets.

- You can create additional working sheets using the new Insert Sheet button, which is conveniently located in the sheet tab tray:

- You can assign a different color scheme to the 2D Model sheet and to all other working sheets by selecting one of the following from the new Drawing Display list on the Colors tab (Solid Edge Options dialog box):
  - 2D Model—Applies the current color scheme settings to the 2D Model drawing area.
  - Sheet—Applies the current color scheme settings to all other drawing areas, such as the working sheets, background sheets, and draw-in-view edit windows.

Previously, all drawing areas had to use the same color scheme.

Example

You can choose a unique color for the 2D Model sheet:
Example

You can use the Drawing Display options to coordinate the color of the sheet background with the color of the sheet tab.

- You can assign Light Aqua to the 2D Model sheet background and to Sheet Tab 1:

- You can assign Light Orange to the working sheet background and to Sheet Tab 2:

- You can show and hide the 2D Model sheet, the background sheets, and the working sheets using the following shortcut menu commands available when a sheet tab is selected:
  - Background
  - Working
  - 2D Model

Previously, you could only show and hide these sheets using the commands on the ribbon in the View tab→Sheet Views group.

- Another new shortcut command, Edit Background, displays the background sheet for direct editing, rather than having to go through the Sheet Setup dialog box.
Chapter 10  Draft enhancements

Slot centerlines, center marks, and callouts

Enhancements to the Automatic Centerlines command

The Automatic Centerlines command now supports assembly drawing views and slot features.

You can:

• Retrieve centerlines and center marks on slots.

![Centerlines and Center Marks on Slot](image)

• Specify the types of annotations to display on slots using the new slot options in the Centerline and Center Mark Options dialog box:
  o Center lines
  o Punch point marks
  o End point center marks
  o Center-of-arc projection lines

• Retrieve and place centerlines and center marks automatically on assembly drawing views. Previously, assembly drawing views were not supported.

Arc centerlines are supported for the Centerline command

Arc centerlines also are supported when adding centerlines manually using the Centerline command. The new Arc option on the Centerline command bar specifies a centerline type.

For more information, see, Place a centerline on a slot.

Dimensions support slot features

• Dimension commands now can be used to add intelligent dimensions to slots. To reference this information, select the Feature Callout option from the Type list on the dimension command bar.
  
  Previously, this option on the Type list was named Hole Callout.

• You now can add dimensions that measure the radius, diameter, arc length, and arc angle to the center of the arc in a curved slot.
Callouts support slot features

The Callout command now can be used to retrieve slot information from the model.

You can:

- Place a slot callout and extract the model information when you select Feature Callout from the Type list on the Callout command bar.
  
  Previously, this option was named Hole Callout.

- Predefine the slot information that you want to retrieve into the callout using the Dimension Style dialog box, and modify the callout information using the Callout Properties dialog box.

- Use the same property text codes for simple slots and counterbore slots as you do for holes to extract the size and depth information into a drawing callout. In addition, two new property text codes are available to extract slot length:

  - \%PH (Path Length), which is the sum of the lengths in the slot sketch.
  
  - \%SH (Overall Length), which is the same as the path length for slots with flat ends, plus the slot width for slots with arc ends.

  For a tabular listing of all available property text codes and the type of information they reference, see Property text codes.

Styles support slot features

In the Dimension Style and Callout Properties dialog boxes, tabs which were previously named Hole Callout have been renamed Feature Callout to support slots and similar model features.

- On the Feature Callout tab, two new property text boxes reference slot type:
  
  - Slot
  
  - Counterbore

- On the Smart Depth tab, two new property text boxes reference slot depth:
  
  - Through
  
  - Finite depth

User-defined table update

The following options now are available in the Table Properties dialog box for user-defined tables in the Draft environment and in Solid Edge 2D Drafting. Previously, these options were available only for model-derived tables, such as parts lists, bend tables, and hole tables.

- The Columns tab is available to add user-defined data columns to a table, and to define the column content and header content for each column.

  To learn more, see Using the Columns tab.
Chapter 10  Draft enhancements

- The Apply button is available on all tabs in the Table Properties dialog box when editing a selected table. You can use this button to see what a table edit looks like without having to close the dialog box.

- The Saved Settings list is available on the General tab for you to select and apply previously defined table formatting. This enables you to standardize table formats among draft documents.

To learn about the options on the General tab, see Defining table size and location.
Chapter  

11 Translator and converter enhancements

PDF Export Options dialog box enhanced

New options on the PDF Export Options dialog box enhance the performance and quality of the output when exporting draft files to PDF.

- The Transparent drawing view backgrounds option controls the display of the background of one or more overlapping shaded drawing views. For example, if the option is not set and you save a file containing an overlapping shaded drawing view (A), the background drawing view is hidden by the overlapping drawing view (B) in the saved PDF file.

![Diagram showing transparent drawing view backgrounds](image)

If the option is set and you save a file containing an overlapping shaded drawing view (A), the background drawing view is not hidden by the overlapping drawing view (B) in the saved PDF file.

![Diagram showing transparent drawing view backgrounds](image)

**Note**

A shaded view can overlap a shaded view, any wireframe view, or other objects such as annotations.
Chapter 11  Translator and converter enhancements

- The Print Quality option specifies the level of print quality for the document. You can specify a value ranging from 72 dpi to 1200 dpi.

Support for multiline text enhanced

The support of multiline text, both for exporting to and importing from AutoCAD, has been enhanced to include:
- Paragraph indentations
- Tabs
- Aspect ratio
- Text position for orientations other than 0, 90, 180, or 270.
- Character spacing

AutoCAD multi-leader objects now supported during import

Solid Edge now supports multileader objects, which are objects that contain a leader, text, or block data, during the import of AutoCAD files. When imported into Solid Edge the text is imported as a single text box with a leader grouped within a block.

AutoCAD version 2013 files now supported during import

Solid Edge now supports the import of AutoCAD version 2013 files.

Draft callouts now exported as multi-line objects in AutoCAD

Solid Edge now exports draft callouts as multi-line text objects when saving Solid Edge documents to AutoCAD format.

Simple dimensions exported to JT

When you export a Solid Edge document to JT format, Solid Edge file properties are written where they can be read by viewers, and other CAD systems, such as NX, that read JT format. Previously, PMI object types supported included datum frames, datum targets, and surface finish symbols. In ST6 simple dimensions has been added to the list of supported object types.

Solid Edge textures exported to JT

A new Export Textures parameter has been added to the SEPVtrn.ini, SEECtoJT.ini, SE2VM.ini, and InsighXTtoJT.ini files that exports textures from Solid Edge parts to a .jt file. The default value for the parameter is 0, which does not export the textures. You can change the value to 1 to export the textures.
For more information, see Saving Solid Edge documents to other formats.

**SolidWorks Data Migration tool**

A new SolidWorks Data Migration tool migrates SolidWorks part, assembly, and drawing files into Solid Edge.

For more information, see SolidWorks data migration.
Chapter 13  User interface changes

Solid Edge themes

Solid Edge ST6 introduces four user interface themes that offer a predefined arrangement of graphical tools, user assistance tools, and docking windows based on your familiarity with Solid Edge or with other CAD products.

<table>
<thead>
<tr>
<th>User interface theme name</th>
<th>Experience level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Assistance</td>
<td>New to CAD</td>
</tr>
<tr>
<td>Some Assistance</td>
<td>SolidWorks Experience</td>
</tr>
<tr>
<td>Maximum Workspace</td>
<td>Solid Edge Expert</td>
</tr>
<tr>
<td>Balanced</td>
<td>Solid Edge Default</td>
</tr>
<tr>
<td>Use my custom theme from the previous release of Solid Edge</td>
<td>Customers who have a custom company theme can select it using this option.</td>
</tr>
</tbody>
</table>

You can choose a user interface theme when you start Solid Edge for the first time after installing the product. You also can select and apply a theme using the Themes menu on the Quick Access toolbar.

For more information and to watch a short video, see Solid Edge themesSolid Edge themes.

Note

You can disable theme selection and the generation of theme folders using the Solid Edge Administrator.

Expanded use of document name formula

The Document Name Formula gives you the capability to replace the display of a document’s file name with a formula composed of document properties. The display of the document name formula is now implemented throughout the Solid Edge user interface including:

- Property Manager
- Occurrence Property Manager
Chapter 13  

*User interface changes*

- Physical Property Manager
- Alternate Assemblies Table
- Configuration Manager
- Assembly Statistics
- Insert Assembly Copy
- Inter-Part Manager
- Reports

To learn more, see these help topics:

- Using the Document Name Formula
- Document Name Formula dialog box
- Helpers page (Solid Edge Options dialog box)

**High-Quality rendering mode**

Solid Edge ST6 now provides the ability to display models in a High-Quality Rendering mode. The new technique will produce more realistic display particularly when a model contains a low triangle count.

![](image)

**Bump Maps**

Solid Edge ST6 now supports the normal map format for use as a bump map. In previous versions, only gray scale was supported. A normal map provides more details for a renderer to use, and therefore produces a higher quality result.
A normal map is used for wall (1) and a gray scale bump map is used for wall (2).

To learn more information, see:
- View Overrides dialog box
- Face Overrides dialog box
- Modify Faces Style dialog box

**Solid Edge Mobile Viewer supports Android**

The Solid Edge Mobile Viewer application is now available for Android. The Android version contains two new buttons for the following:
- Share
Chapter 13  User interface changes

- Sample File Display Toggle

For more information, see:
- Using the Mobile Viewer
Chapter

14 Social media

Solid Edge social media dashboard

This is a para in the topic template. Link to the appropriate topic in help using a <linkURL> tag, e.g., Spacing tab (Dimension Style and Dimension Properties)
Chapter 15 Administering Solid Edge

Administering Solid Edge

This section of What’s New provides Solid Edge administrators with a quick overview of features of the new release.

New Preferences folder for customizing Solid Edge

Installation

Solid Edge offers three product document management integration solutions. Each is packaged independently. Choose and install the solution that matches your license. Each solution is available from the installation DVD as follows:

- Solid Edge Insight Client
- Solid Edge Teamcenter Client
- Solid Edge SP Client

Additionally, the Solid Edge Embedded Client Administrator is renamed to Solid Edge Teamcenter Administrator and is available from the installation media, under 32-bit applications. Use this setup for either 32 or 64-bit installations.

Licensing

For detailed information, you can access the Solid Edge License Management web site at: https://www2.industrysoftware.automation.siemens.com/LicenseManagement/Application. A web key is required to access the site.

Support

Detailed information is now available from the web site: http://support.industrysoftware.automation.siemens.com/gtac.shtml

Preferences folder

The ST6 product structure now includes a Preferences folder which contains files you can edit to customize your installation. For example, SELicence.dat and material .mtl files are delivered in this location. The purpose of this enhancement is to allow non-administrator users to license and run the product as effectively as possible.
The following is a list of existing folders which also allow a non-administrator user write access:

- Templates
- Training
- Sample Blocks
- Piping Route
- Frames
- Images
- SDK
- Custom

Similar changes are also implemented for the Insight Connect and the 2D Drafting packages.
Chapter

16 User assistance tools

YouTube in Solid Edge

Users can directly capture videos inside Solid Edge. You can save these videos locally and also upload them to YouTube. A YouTube docking pane is available for viewing and searching for Solid Edge related videos from within Solid Edge. The purpose of this tool is to provide the Solid Edge community a mechanism for sharing knowledge and learning from other users.

Web-served help

Now you can choose to use web help or local help to display Solid Edge user assistance. Web help uses your default Internet browser to display HTML content. Local help is displayed in the traditional compiled help window.

In ST6, web help is the default option specified on the Helpers tab (Solid Edge Options dialog box).

For more information, see Choosing a help system.

New Solid Edge Help docking pane

Solid Edge Help now has its own docking pane. There you can find links to Solid Edge Help, What’s New, User Interface Basics, Document Management, Programming with Solid Edge, and a link to the technical support web site.

The contents of the Solid Edge Help pane varies with the Solid Edge version or product configuration.

1. On the ribbon, click the Help index icon .
   This should display two user assistance tabs along the perimeter of the Solid Edge window. These tabs may be located along the right or left side of the window, depending on your user interface setup.

2. Click the Solid Edge Help tab .

Note

If you do not see the Solid Edge Help tab, it may be closed. You can reopen it using the View tab→Show group→Panes command on the command ribbon.
Learning materials are available in the Knowledge Center docking pane

Links to training materials and specialized courses have been moved to the Knowledge Center, a new docking pane in Solid Edge.

1. On the ribbon, click the Help index icon 
   
   This should display two user assistance tabs along the perimeter of the Solid Edge window. These tabs may be located along the right or left side of the window, depending on your user interface setup.

2. Click the Knowledge Center tab 

   **Note**
   If you do not see the Knowledge Center tab, it may be closed. You can reopen it using the View tab→Show group→Panes command on the command ribbon.

3. Choose from the following options:
   - **Test drive Solid Edge**—Displays a PDF file (testdrive_se.pdf), which contains activities that provide an overview of Solid Edge.
   - **Learning Portal**—Use the Learning Portal to choose how you want to learn: by role, model feature, or task. (The Learning Portal requires Internet access.)
   - **Self-paced training library**—Choose from a list of all available courses in the Solid Edge training library. You can work through self-paced training on the web or download a course PDF file. **Solid Edge Self-Paced Training library**

   **Note**
   The contents of the Knowledge Center pane varies with the Solid Edge version or product configuration.

Contextual help

- You can press F1 whenever you need help during a design session.

- You can press Shift+F1 to initiate context help . When this tool is displayed, you can click a command on the ribbon to display help.